Document Number:
Department:
Contact Name:
Email:
Phone:
Version:
Last Update: June 30, 2006
Confidential Business Information

This documentation is proprietary information of New Mexico State University (NMSU) and is not to be copied, reproduced, lent or disposed of, nor used for any purpose other than that for which it is specifically provided without the written permission of NMSU.

Prepared For: Release 7.x

Prepared By:
New Mexico State University
P.O. Box 30001
Las Cruces, New Mexico 88003
United States of America

Issued: June 2006

In preparing and providing this publication, NMSU is not rendering legal, accounting, or other similar professional services. NMSU makes no claims that an institution’s use of this publication or the software for which it is provided will insure compliance with applicable federal or state laws, rules, or regulations. Each organization should seek legal, accounting and other similar professional services from competent providers of the organization's own choosing.

© 2006, Regents of New Mexico State University.

© 1992-1995, 1997, 1999-2002, 2003, Systems & Computer Technology Corporation. All rights reserved. The unauthorized possession, use, reproduction, distribution, display, or disclosure of this material or the information contained herein is prohibited.

“SCT,” SunGard SCT, the SCT logo, “Banner” and the Banner logo are trademarks of SunGard SCT. Third-party hardware and software product names and trademarks are owned by their respective third-party owners/providers, and SunGard SCT makes no claim to such names or trademarks.

Use of this material is solely for the support of SunGard SCT Banner products and NMSU.

For more information about this document, contact training@nmsu.edu.
Table of Contents

Introducing the UNO Project ....................................................................................................5
Introducing SunGard SCT Banner .............................................................................................7
  Benefits of SCT Banner ..........................................................................................................8
Introducing the Manual ...............................................................................................................9
  Prerequisites ............................................................................................................................9
  Objectives of this Manual .......................................................................................................9
  Document Conventions .........................................................................................................10
Getting Started ..........................................................................................................................11
  Getting Access to Banner .......................................................................................................11
  Checking the Browser ............................................................................................................13
  Understanding Product Conventions .......................................................................................14
    Terminology ..........................................................................................................................14
    Banner Structure ..................................................................................................................15
    Naming Conventions ...........................................................................................................15
  Logging onto Banner ............................................................................................................16
  Introducing the Banner Interface .............................................................................................18
General Student Overview .......................................................................................................19
  Search for a General Student Record (SGASTDN) ...............................................................19
  Viewing a General Student Record (SGASTDN) .................................................................21
  Viewing Information in General Student (SGASTDN): General Learner Tab ....................23
  Viewing Curricula ..................................................................................................................23
  Making Changes to Curricula ...............................................................................................24
    Adding a Field of Study .........................................................................................................29
    Adding or Changing a Field of Study ..................................................................................33
  Adding or Changing Advisor Information .............................................................................33
    Adding New Advisors to Current Term ..............................................................................33
    Adding Advisors to Future Term .........................................................................................37
    Changing All Advisors for Future Term ..............................................................................42
  Viewing Student Cohort and Attribute Information .............................................................47
    Viewing Cohorts ...................................................................................................................48
    Viewing Student Attributes .................................................................................................50
Appendix A: Glossary ...............................................................................................................51
Appendix B: Compatible Browsers ............................................................................................55
Introducing the UNO Project

In June 2003, NMSU pursued an administrative systems software replacement project named “UNO,” or “Unifying NMSU Online.” The goal of the UNO Project is to electronically integrate all administrative functions of the university. To accomplish this goal, NMSU joined more than 1,100 other higher education institutions in choosing SunGard SCT Banner because of its minimal system modification features.

In addition to implementing SCT Banner, NMSU has also implemented other systems to support SCT Banner, including SCT Luminis, SCT Luminis CMS, Cognos ReportNet, Cognos PowerPlay, and SCT Matrix Student Marketing System.

Major goals of the UNO Project are to update our current processes that use information systems, consolidate core university information into an integrated database, and create new methods of web-based self-service for university procedures and information.

The following systems are described:

<table>
<thead>
<tr>
<th>System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCT Banner</td>
<td>SCT Banner is the suite used for administrative data enterprise wide.</td>
</tr>
<tr>
<td>SCT Luminis</td>
<td>SCT Luminis is the myNMSU portal. The portal is the access point for Students, Staff, and Faculty to self-service options including: entering and changing personal information, time and leave, e-mail, and calendar.</td>
</tr>
<tr>
<td>SCT Luminis CMS</td>
<td>SCT Luminis CMS is a Content Management System designed to help organize and maintain Web content and facilitate consistency of content, navigation, and look-and-feel of the University’s entire Web site.</td>
</tr>
<tr>
<td>Cognos ReportNet</td>
<td>Cognos ReportNet is the web-based enterprise reporting tool, designed for you to generate custom reports.</td>
</tr>
<tr>
<td>Cognos PowerPlay</td>
<td>Cognos PowerPlay is used to analyze large amount of data.</td>
</tr>
<tr>
<td>SCT Matrix Student Marketing System</td>
<td>SCT Matrix SMS enables NMSU to manage the recruiting and admissions process.</td>
</tr>
</tbody>
</table>
Introducing SunGard SCT Banner

SunGard SCT Banner is the new Enterprise Resource Planning (ERP) suite that integrates all departments and functions across NMSU onto a single computer system that can serve each individual department’s need.

Internet Native Banner (INB) is the Web version of the SCT Banner suite NMSU employees will use to access vital university administrative information. INB can be accessed through a Web browser.

The suite acts as an interface between users and an Oracle database containing NMSU administrative data.

The NMSU SCT Banner suite is composed of six systems: Student, Financial, General, Advancement, Financial Aid, and Human Resources. The integrated suite uses rules and validation tables to ensure the data are entered and accessed correctly. Since the Banner systems are highly integrated and share a common Oracle database, all users of the system see common database information in real time.
Benefits of SCT Banner

SCT has been providing services to the higher education market for over three decades. Developed specifically for higher education institutions, SCT Banner offers the following benefits:

- Available 24 hours a day, 7-days-a-week access from any authorized web-enabled computer.
- Shared data is entered only once.
- Individual non-social security ID number for students, faculty, and staff.
- Electronic signatures, forms and workflow.
- Oracle database as a basis for generating reports.
- Ability to implement improved methods to track enrollment.
- Ability to define clear and consistent data definitions.
- Strong baseline system to allow NMSU ICT staff to focus on improvements to the system.
- Integration with NMSU’s web-based course management system, WebCT.
Introducing the Manual

The Banner User Guide: General Student Manual is a stand-alone manual, which covers a variety of business operations processes and accompanying procedures in Banner 7. Not only does the General Student Manual cover how to get started using SCT Banner 7 basics, but also it covers how to perform specific daily job tasks, such as: viewing and searching for student information, adding and changing advisor information, adding or changing major/minor, and adding or changing additional student information.

Prerequisites

You should know what your specific business requirements are when you review this manual. This helps you to rapidly understand how the manual’s contents can help you to meet them.

You should be able to access and navigate the Banner suite to ensure that you can successfully complete any procedures presented in this manual. To learn how to access and navigate the Banner suite, you should either complete the ICT Training Services General Navigation Training Course, or complete the UNO Banner General Navigation Demonstration at: http://www.nmsu.edu/~fsa/files/robodemos/General%20Navigation.htm.

Successful Banner users have experience using Microsoft Windows 2000 version or newer and Windows-compatible Internet browsers or one of the compatible browsers listed in Appendix C: Compatible Browsers.

Objectives of this Manual

This manual will introduce you to SCT Banner basics. Once you review this manual you will be able to:

- Search for a General Student Record (SGASTDN)
- Viewing a General Student Record (SGASTDN)
- Viewing Information in General Student (SGASTDN): General Learner Tab
- Viewing Curricula
- Making Changes to Curricula
- Adding or Changing Advisor Information
- Viewing Student Cohort and Attribute Information
**Document Conventions**

These document conventions will point out special information, and help you to successfully follow step-by-step instructions in this manual.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Notes</th>
<th>Tips</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Note]</td>
<td>alert readers of potential problems or to emphasize special points.</td>
<td>suggest shortcuts or special hints to make a process easier.</td>
</tr>
</tbody>
</table>

**Click vs. Select**

**Click** is used for commands, command buttons, option buttons, and choosing options in a list, gallery or palette.

Examples:

- On the **Tools** menu, click **Options**, and then click the **View** tab.
- In the **Options** dialog box, click the **View** tab.

**Select** is more passive because it may not trigger an action. **Select** is used to refer to marking text, cells, checkboxes, option buttons, and similar items that will then be subject to a user action.

**Buttons** provide visual examples of Banner navigation aids that you can use to accomplish specific tasks.

---

*Examples:* On the **Tools** menu, click **Options**, and then click the **View** tab. In the **Options** dialog box, click the **View** tab.
Getting Started

In this section you are given some background information that you will need before you can start using Banner, including understanding how to access the system and a basic understanding of the system design.

Getting Access to Banner

Access to Banner is requested on the Web from Financial Systems Administration (FSA). The following instructions guide you through the process of gaining access to Banner. Once you have completed the following steps to request access to Banner, you will receive an e-mail verifying that access has been granted and notifying you of your password.

Instructions

Open a browser session.

Type the URL: http://www.nmsu.edu/~boffice.
The Business, Finance, and Human Resources Web site displays.

On the Business, Finance, and Human Resources Web site, click the Reports, Resources and Forms link.
The Reports, Resources and Forms Web page displays.
On the Reports, Resources & Forms Web page, click the Forms link. The Business & Finance Forms Web page displays.

Scroll to find the Request for Computer Systems Access form and click the E-form icon to open the form.
The Request for Computer Systems Access form contains interactive form fields that allow you to type the information directly on the form.

Complete the applicable sections for requested systems.

Print the form.

Read and sign the disclosure agreement.

Submit to the necessary approver for the required approval.

Forward the original form to Financial Systems Administration, MSC 3FSA, Hadley Hall room 12, or fax a copy to 646-1994.

Keep a copy for your files.

If assistance is needed to complete the form, please contact 646-HELP (4357).

Once the form has been reviewed by FSA, you will be contacted by phone or e-mail with your Banner approval status. If you have any questions regarding your access you can contact FSA at 646-HELP (4357).

Checking the Browser

In order to successfully use Banner, you must use one of the approved browsers. Although you can log on to Banner with any browser, certain features might not work in unapproved browsers.

The first step in troubleshooting any Banner problem will be to verify that the browser is supported. If your browser is not supported, it will be obvious because buttons won’t work, or features won’t load.

There may also be additional installs when you first access Banner such as Oracle JInitiator, and/or a Sun plug-in. These additional installs will automatically prompt you the first time you access Banner from your machine.

A complete list of the browsers supported by Banner and the needed installs are found in Appendix B: Compatible Browsers.

If you have any questions or problems with your browser, please contact ICT Help Desk at help@nmsu.edu or 646-1840.
Understanding Product Conventions

When you are first introduced to a new system, it is like learning a new language. This section exposes you to some of the basic Banner terms, the system structure, and the naming conventions used in Banner and this manual.

Terminology

Understanding the terms provided in this manual help you to understand the explanations and instructions presented in this manual and to present clear, specific questions that you may have about the information provided.

This table defines the basic components of the Banner suite.

<table>
<thead>
<tr>
<th><strong>Suite</strong></th>
<th>The SunGard SCT Banner suite is an administrative software application developed specifically for higher education institutions by SunGard Systems and Computer Technology Corporation (SCT). The software acts as an interface between users and an Oracle database containing New Mexico State University administrative data.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System</strong></td>
<td>The NMSU Banner suite is composed of six systems: General, Student, Advancement, Financial, Human Resources, and Financial Aid.</td>
</tr>
<tr>
<td><strong>Modules</strong></td>
<td>Each system is composed of specific modules that “break out” components of the system.</td>
</tr>
<tr>
<td><strong>Forms</strong></td>
<td>Forms are screens that contain fields.</td>
</tr>
<tr>
<td><strong>Fields</strong></td>
<td>Fields are areas in a form that are used either to display specific data (such as a last name, address, or NMSU ID number), or to insert data.</td>
</tr>
<tr>
<td><strong>Validation Tables</strong></td>
<td>Validation tables contain Lists of Values (LOVs) that are pre-defined for a specific field.</td>
</tr>
<tr>
<td><strong>Blocks</strong></td>
<td>Blocks are groups of related fields within a form.</td>
</tr>
</tbody>
</table>

For more terms, see Appendix A: Glossary.
Banner Structure

Banner is organized as a hierarchy. The Banner hierarchy includes:

- Suite
- Systems
- Modules
- Forms
- Fields.

This image shows the structure of SCT Banner Suite components including sample systems, modules, forms, and fields.

![Banner Structure Diagram]

Naming Conventions

All Banner forms, reports, jobs, and tables have seven character names that follow the structure rules outlined below.

**Using the Student Person Identification or SOAIDEN form as an example:**

<table>
<thead>
<tr>
<th>Name</th>
<th>Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>S O A I D E N</td>
<td>1 2 3 4 5 6 7</td>
</tr>
</tbody>
</table>

**Position 1**—identifies the product owning the form, report, process or table. In the case of the SOAIDEN form, the first letter S refers to **Student**.

**Position 2**—identifies the application module owning the form, report, process or table. In the case of the SOAIDEN form, the second letter O refers to **Operations**.

**Position 3**—identifies the type of form, report, job, or table. In the case of the SOAIDEN form, the third letter A refers to an **Application** form.
Positions 4, 5, 6, and 7—are unique identifiers for the form, report, job, or table. In the case of the SOAIDEN form, the last four letters IDEN refers to Identification.

Logging onto Banner

Banner supports authenticated user access, meaning that the system verifies your credentials and you are given access to the system based on your assigned security. To use Banner as an authenticated user, you must successfully log on by providing your credentials: NMSU Username, and Banner Password.

Instructions

1. Open a browser session.

Type the URL: http://www.nmsu.edu/erp/.

The Logon screen displays.

![You can create a bookmark in your browser for quick access to Banner.](image)

Type your NMSU Username and Banner Password.
Select OK.

Your Banner session begins with the following Main Menu.
Introducing the Banner Interface

Internet Native Banner (INB) is the Web version of the new ERP system NMSU employees will use to access vital university administrative information. You must access INB through a Web browser.

Once you have logged onto Banner you will be presented with the Main Menu. This menu is the starting point for navigating throughout Banner.
General Student Overview

This manual covers information for viewing and using forms in General Student that will allow the Registrar’s Office staff to maintain current and historical information about a student. The Banner system requires a General Student Record to exist before a student can register or be registered for a course and have tuition and fees assessed. The forms that feed into General Student (SGASTDN) are used by Banner to ensure that the student is registered into the correct courses and is assessed the right fees and tuition.

This section describes how to:

- Search for a General Student Record (SGASTDN)
- Viewing a General Student Record (SGASTDN)
- Viewing Information in General Student (SGASTDN): General Learner Tab
- Viewing Curricula
- Making Changes to Curricula
- Adding or Changing Advisor Information
- Viewing Student Cohort and Attribute Information

There are tabs in General Student (SGASTDN) that are not currently being used by NMSU: Activities, Comments, and Miscellaneous.

Search for a General Student Record (SGASTDN)

In order to view information in the General Student (SGASTDN) form, a person must be in the system as a General Person and gone through the Admissions’ process to be admitted as a General Student. If the General Person has completed the Admissions’ process and is now a General Student, you can search for and view a General Student (SGASTDN) record.

To Search for a General Student Record, perform these steps:

Instructions

1. On the Main Menu, in the Go To field, type SGASTDN and press ENTER. The General Student (SGASTDN) form displays.
2. In the ID field, perform one of the following actions:
   a. Type the student ID, OR
   b. Type the student’s Name in field to the right of the ID field, OR
   c. Click the Search button.

   The Option List menu is displayed.

3. On the Option List menu, click Person Search.
   The Person Search (SOAIDEN) form is displayed.
4. In the Last Name field, enter the student's Last Name.

5. Click the Execute Query button.
   A list is displayed.

6. Scroll down the list and double click on the specified student's ID.
   The ID field on the SGASTDN form is automatically filled.

7. In the Term field, leave the Term field blank.

   The Term field does not need to be filled in if you want to pull up the most
   CURRENT term and all past terms. If there is an entry in the Term field, you will
   only see the term you entered and not the most current nor the history of past
   terms.

Viewing a General Student Record (SGASTDN)

Unless changes are made to the General Student (SGASTDN) form, the same General
Student (SGASTDN) record is used indefinitely. When a change is made, however, a new
General Student (SGASTDN) record will be generated and the To Term will change to the
term entered in the key block called the effective term.

An Effective Term is the From Term date up to, but NOT including, the To
Term date.
There can be one General Student (SGASTDN) record per term or one for the entirety of a student's enrollment if no changes are made to the record. A new General Student (SGASTDN) record is created when certain fields are changed:

- Student status
- Student type
- Residency
- Rate changes.

If there are several changes within the same term, then the same General Student (SGASTDN) record will be used to track the changes; however, if any one of these fields is changed during a term then a new General Student (SGASTDN) record will be generated for that term. These fields can be changed multiple times during the course of the current term; however, only the changes in effect at the end of that term will be recorded.

If no changes have been made to the General Student (SGASTDN) record, it's possible that the From Term in the General Learner block of the General Student (SGASTDN) form may not be the most current term. The best way to make sure you are in the most current term is to leave the Term field empty and check the To Term for the end of time date (9999999).

If other SGASTDN records exist, a scroll bar will appear to the right of the General Learner block that will let you view other General Student (SGASTDN) records.

An Effective Term is the From Term date up to, but NOT including, the To Term date.
Viewing Information in General Student (SGASTDN): General Learner Tab

Changes made in the General Student (SGASTDN): General Learner tab is the responsibility of the Registrar’s Office. Here is a table of terms for your understanding:

<table>
<thead>
<tr>
<th>Student Status</th>
<th>A student’s status is changed to inactive if the student has not been enrolled for one calendar year.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student Type</td>
<td>This field identifies the student’s type for the effective term, such as new or continuing.</td>
</tr>
<tr>
<td>Residency</td>
<td>This field identifies the student’s residency for the effective term, helping to determine tuition.</td>
</tr>
<tr>
<td>Fee Assessment Rate</td>
<td>This field identifies a student’s specific assessment rate for the effective term.</td>
</tr>
<tr>
<td>Class</td>
<td>This field states a student’s current class (freshman, sophomore). It is not a static field but changes based on completed credits, and other designated attributes for graduate students.</td>
</tr>
<tr>
<td>Full- or Part-time</td>
<td>Not currently used.</td>
</tr>
</tbody>
</table>

Viewing Curricula

You may view a student’s curriculum in SGASTDN; however, in order to make changes to a student’s program, major, minor, degree, or college, you must use the Curricula form in Student Course Registration (SFAREGS), as documented in Making Changes to Curricula.

Banner uses non-destructive handling of records whenever a change is made in Curricula. This means that, when a change is made to Curricula, the system records it as three separate records: the original record that is still listed as active but not current, a copy of the original record that is both inactive and not current, and the new record.

<table>
<thead>
<tr>
<th>Current</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Record</td>
<td>No</td>
</tr>
<tr>
<td>Duplicate</td>
<td>No</td>
</tr>
<tr>
<td>New Record</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Be sure you are looking at the current, active record to find the student’s curriculum for the term.
You can have multiple curricula records attached to any one General Student (SGASTDN) record; however, when a change is made to the Curricula form, like changing of majors, then a new General Student (SGASTDN) record is generated. Within that term, however, curricula changes can be continuously made and there will be no new General Student (SGASTDN) record. There will be records of every curricula change.

If you make an error in selecting the Program, Banner will record it as a curriculum record and create another set of three records when you make the correction.

### Terminology

<table>
<thead>
<tr>
<th>Catalog Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field of Study</strong></td>
<td>The catalog regulations your cohort was admitted under and must graduate with.</td>
</tr>
<tr>
<td><strong>Program</strong></td>
<td>Program is new to NMSU. It combines campus, college, and student level (MA – HSC – BS is short for “Main Campus - Human and Community Service – Bachelor’s of Science”). In order to make changes to major, college, or degree, you must change the overall program.</td>
</tr>
</tbody>
</table>

### Making Changes to Curricula

If a student needs changes made to their major, minor, degree, or college, you must use the Curricula form in Student Course Registration (SFAREGS).
To **Make a Change to Curricula**, perform these steps:

**Instructions**

1. On the **Main Menu**, in the **Go To** field, type **SFAREGS** and press **ENTER**. The **Student Course Registration (SFAREGS)** form displays.

2. In the **ID** field, perform one of the following actions:
   a. Type the student **ID**, OR
   b. Type the student **Name** in field to the right of the **ID** field, OR
   c. Click the **Search** button 📦. The **Option List** menu is displayed.
3. On the **Option List** menu, click **Person Search**. The **Person Search** (SOAIDEN) form is displayed.

4. In the **Last Name** field, enter the student’s **Last Name**.

5. Click the **Execute Query** button ![Execute Query](image). A list is displayed.

6. Scroll down the list and double click on the specified student’s **ID**. The **ID** field on the **SFAREGS** form automatically filled.
7. Type the term you want to work with in the Term field and next block down. The Student Course Registration (SFAREGS) form auto-populates.

8. Click on the Curricula tab. The Curricula form is displayed.

Program is new to NMSU. It combines campus, college, and student level (MA-HSC-BS is short for "Main Campus- Human and Community Service-Bachelor’s of Science"). In order to make changes to major, college, or degree, you must change the overall program.

9. On the Curricula form, click the Change Curricula button. All information in the form will disappear.

10. Click on the Program Search button. This will call the Program Options List.
11. Click on All Program Codes. The Program Codes table is displayed.

12. Select the program that the student has chosen. The Curricula form will auto-populate the Level, Campus, College, and Degree in the Curriculum block, and Major and Department in the Field of Study block.
Banner does not allow you to change separate pieces of information in Curricula. To change College, Degree, Major, or Program, you must change the overall program.

13. In the Priority field, type 1.

14. At this time, take one of the following actions:
   a. If you are Adding a Field of Study, such as a minor, next block down to the Field of Study block OR
   b. Click Save button if you are done.

You cannot alter the auto-populated information in the other fields.

Adding a Field of Study

The Field of Study block is used to add information on minors, concentrations, and supplementary degrees.

Minors and Supplementary Degrees are not attached to any particular program.

1. Next block to the Field of Study block and click in a blank record.
2. In the Priority field, type 2.

3. Tab over to Type field and click the Type Search button. The Learner Field of Study Type table is displayed.

4. Select CONCENTRATION, MINOR, or SUPPLEMENTARY from the Learner Field of Study Type list.

   In the Status field, IN PROGRESS should be the default.

5. Tab to the Field of Study field, and click on the Field of Study Search button. The All Minor Codes Option List displays.
In the case of Supplementary Major or Concentration, the Option List will display all available Supplementary Majors or Concentrations in the same manner, so please follow this procedure for these two options.

6. Click on All Minor Codes. The All Minor Codes table displays.

7. From the Minor Code table, select the minor.

8. Tab to the Department field, and click on the Department Search button. The Department Option List is displayed.

9. Click on All Department Codes.
10. From the **Department Validation** table, select the department.

11. At this time, take one of the following actions:
   
a. If you are **Adding an Additional Field of Study**, click in the next blank **Field of Study** record **OR**

b. Click **Save** button **if** you are done.

☆ Once choices have been made, you can’t make changes to these fields without saving and clicking the Change Curriculum button.
Adding or Changing a Field of Study

If a student wants to add another Field of Study or change their current Field of Study, the entire process for Changing a Major through Adding a Field of Study is followed.

Because of Banner’s non-destructive handling of information, any change to the Curricula form will create a new Curricula record and make the prior record INACTIVE. That is, three records will be recorded each time a change is made to the Curricula form: the old Curricula record, a copy of the old Curricula record stating that it is INACTIVE, and the new Curricula record that you are changing.

Adding or Changing Advisor Information

The Multiple Advisor (SGAADVR) form provides a complete advising history for students by associating the student with an unlimited number of advisors through an effective term range. That is, for a specified From Term up to—but not included—To Term, all advisors assigned to a student are recorded. There can be many advisors assigned to a student, but only one primary advisor, and one of the advisors must be a Primary. If the primary advisor is deleted, then a secondary advisor must be selected as the Primary.

It is the Terms that determine the user’s ability to alter information. The form cannot be altered if the Term field and the From Term field dates are not the same. If they are the same, however, then the form is accessible on all levels.

Adding New Advisors to Current Term

If the student currently has no advisors, or is adding advisors to the current term, you can add advisors.
To Add a New Advisor to the Current Term, perform these steps:

Instructions

1. On the **Main Menu**, in the **Go To** field, type **SGAADVR** and press **ENTER**. The **Multiple Advisor** (SGAADVR) form displays.

   ![Multiple Advisor Form Image]

   **Advisor Information**
   - **ID**
   - **Maintenance**
   - **Advisor Type**
   - **Primary Indicator**

2. In the **ID** field, perform one of the following actions:
   
   a. Type the student **ID**, **OR**
   
   b. Type the student **Name** in field to the right of the **ID** field, **OR**

   c. Click the **Search** button.

   The **Person Search** (SOAIDEN) form is displayed.
3. In the **Last Name** field, enter the student's **Last Name**.

4. Click the **Execute Query** button 📦. A list is displayed.

5. Scroll down the list and double click on the specified student’s **ID**. The **ID** field on the **SGAADVR** form is automatically filled.

6. In the **Term** field, fill in the current **Term**.

7. Next block down to **ID** field and click on the **ID Search** button 🔍. The **Faculty/Advisor Query (SIAIQRY)** form is displayed.
In Faculty/Advisor Query (SIAIQRY), you can wild card search in any of the criteria to find an advisor; however, ID%, Last Name%, or College abbreviation are the easiest to use.

8. Search for an advisor using a wild card search, such as ID%, Last Name %, or using a college abbreviation, and press F8 to run the query.

9. Double click on the advisor’s name and their information will populate the Multiple Advisor (SGAADVR) form.
10. Click the **Advisory Type** button and select **MAJR**.

   *MAJR is currently the only option; however, it must be selected in order to complete the form.*

11. Select the **Primary Indicator** checkbox if this is the only advisor.

   *There must be at least one Primary advisor. If you are adding more advisors, you can change the Primary later.*

12. At this time, take one of the following actions:
   
a. If you are **Adding an Additional Advisor**, click in the next empty **Advisor Information ID** record and repeat the process **OR**

b. Click **Save** button if you are done.

**Adding Advisors to Future Term**

If a student has already listed advisors and would like to add more, a student can do so for a future term.

**To Add an Advisor to a Future Term**, perform these steps:
Instructions

1. On the Main Menu, in the Go To field, type SGAADVR and press ENTER. The Multiple Advisor (SGAADVR) form displays.

2. In the ID field, perform one of the following actions:
   a. Type the student ID, OR
   b. Type the student Name in field to the right of the ID field, OR
   c. Click the Search button. The Person Search (SOAIDEN) form is displayed.
3. In the **Last Name** field, enter the student's **Last Name**.

4. Click the **Execute Query** button 🕵️‍♂️. A list is displayed.

5. Scroll down the list and double click on the specified student's **ID**. The **ID** field on the **SGAADVR** form is automatically filled.

6. In the **Term** field, fill in the **Term** the change is effective, such as the next term. If the term in the **Term** field is not the same as the **From Term**, then the record cannot be changed until the **Maintenance** button is clicked.

7. Click the **Maintenance** button 🖼️. The **Options List** appears
8. Click on **Copy Advisor**. Now, the **From Term** block is the same as the **Term** field. Changes can be made to **Multiple Advisor** (SGAADVR).

9. Next block down to **ID** field and click on the **ID Search** button. The **Faculty/Advisor Query** (**SIAIQRY**) form is displayed.
In Faculty/Advisor Query (SIAIQRY), you can wild card search in any of the criteria to find an advisor; however, ID%, Last Name%, or College abbreviation are the easiest to use.

10. Search for an advisor using a wild card search, such as ID%, Last Name %, or using a college abbreviation, and press F8 to run the query.

11. Double click on the advisor’s name and their information will populate the Multiple Advisor (SGAADVR) form.
12. Click the Advisory Type button ▼, and select MAJR.

MAJR is currently the only option; however, it must be selected in order to complete the form.

13. Select the Primary Indicator checkbox if this is the only advisor.

There must be at least one Primary advisor. If you are adding more advisors, you can change the Primary later.

14. At this time, take one of the following actions:

   a. If you are Adding an Additional Advisor, click in the next blank Advisor Information ID block and repeat the process OR

   b. Click Save button ▼ if you are done.

Changing All Advisors for Future Term

This procedure is for changing a student's colleges and all advisors for a future term.

To Change All Advisors for a Future Term, perform these steps:

Instructions
1. On the **Main Menu**, in the **Go To** field, type **SGAADVR** and press **ENTER**. The **Multiple Advisor** (**SGAADVR**) form displays.

2. In the **ID** field, perform one of the following actions:
   a. Type the student **ID**, **OR**
   b. Type the student **Name** in field to the right of the **ID** field, **OR**
   c. Click the **Search** button [ ]
      The **Person Search** (**SOIADEN**) form is displayed.
3. In the Last Name field, enter the student’s Last Name.

4. Click the Execute Query button. A list is displayed.

5. Scroll down the list and double click on the specified student’s ID. The ID field on the SGAADVR form is automatically filled.

6. In the Term field, fill in the Term the change is effective, such as the next term. The record cannot be changed if the term date in the Term field is not the same as the From Term, then the record cannot be changed until the Maintenance button is clicked.

7. Click the Maintenance button. The Options List appears.
8. Click on **End Advisor**. This changes the **To Term** to the same date as the **Term** field.

   *This ends ALL advisors previously listed and starts a new effective term beginning with the new To Term date.*

9. Save and rollback. Now, the **From Term** block is the same as the **Term** field. Changes can be made to **Multiple Advisor** (SGAADVR).

10. Next block down to **ID** field and click on the **ID Search** button. The **Faculty/Advisor Query** (SIAIQRY) form is displayed.
In Faculty/Advisor Query (SIAIQRY), you can wild card search in any of the criteria to find an advisor; however, ID%, Last Name%, or College abbreviation are the easiest to use.

11. Search for an advisor using a wild card search, such as ID%, Last Name %, or using a college abbreviation, and press F8 to run the query.

12. Double click on the advisor’s name and their information will populate the Multiple Advisor (SGAADVR) form.
13. Click the Advisory Type button, and select MAJR.

*MAJR is currently the only option; however, it must be selected in order to complete the form.*

14. Select the Primary Indicator checkbox if this is the only advisor.

*There must be at least one Primary advisor. If you are adding more advisors, you can change the Primary later.*

15. At this time, take one of the following actions:
   a. If you are Adding an Additional Advisor, click in the next blank Advisor Information ID block and repeat the process OR
   b. Click Save button if you are done.

**Viewing Student Cohort and Attribute Information**

Cohort information is used to designate certain students into a group that can be tracked for specified details, such as students designated as Crimson Scholars. Although there are cohorts already designated in Banner, cohorts can be created in the system for specific
Viewing cohorts

To View Cohort Codes to a Student’s Record, perform these steps:

Instructions

1. On the Main Menu, in the Go To field, type SGASADD and press ENTER. The Additional Student Information (SGASADD) form displays.

2. In the ID field, perform one of the following actions:
   a. Type the student ID, OR
   b. Type the student Name in field to the right of the ID field, OR
   c. Click the Search button. The Person Search (SOAIDEN) form is displayed.
3. In the **Last Name** field, enter the student’s **Last Name**.

4. Click the **Execute Query** button 🕵️‍♂️. A list is displayed.

5. Scroll down the list and double click on the specified student’s **ID**. The **ID** field on SGASADD automatically fills.

6. Type the term date you are working with in the **Term** field.

7. Next block down to the **From Term** field. The date will automatically fill with the most current **Additional Student Information** (SGASADD) term date in the **From Term** field. Term dates in both the **Term** and the **From Term** fields should match for most current information.
Viewing Student Attributes

**Student Attributes** are used for fee assessment by certain departments, such as Accounts Receivable. Although you may have access to **Student Attributes**, touching them may affect student fee assessment and any changes will be recorded in the system under the user’s ID.

Students may or may not have Attributes assigned to them. Student Attributes are used for identifying students who:

- Qualify for special tuition rates, such as senior citizens and WICHE recipients.
- Are classified as graduate students, such as Regular Masters and Doctoral Qualifying.
- Are granted waivers from English and/or Math Basic Skills Requirements.
## Appendix A: Glossary

The following is a glossary of standard terms used by SunGard SCT Banner.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert Box</td>
<td>A type of pop-up dialog box that appears to notify you of particular conditions that may affect either the kind of information they can enter or how the information is entered. An alert box requires that you acknowledge the message to continue.</td>
</tr>
<tr>
<td>Application Form</td>
<td>A form used to enter, update, or query existing information. (An application form will have the letter “A” in the third position of the form name).</td>
</tr>
<tr>
<td>Block</td>
<td>A block visually displays a group of related fields within a form, and is generally separated by a solid line.</td>
</tr>
<tr>
<td>Calling Form</td>
<td>A form from which another form is (or has been) accessed.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Allows you to exit from an Option List, List of Values, Editor window, or Dynamic Help.</td>
</tr>
<tr>
<td>Clear Form</td>
<td>Allows you to clear all information from a form and returns them to the first enterable field in the key information area.</td>
</tr>
<tr>
<td>Commit</td>
<td>Allows you to save all changes made to a form since their last saved changes.</td>
</tr>
<tr>
<td>Count Hits</td>
<td>A function that allows you to count the number of records, in “query mode,” that meet specific search criteria. The number of records is displayed in the Auto Help Line.</td>
</tr>
<tr>
<td>Count Query Hits</td>
<td>A function that allows you, after specific search criteria are met in “query mode,” to retrieve records. After a record is retrieved, a user can then select the Execute Query Function.</td>
</tr>
<tr>
<td>Dialog Box</td>
<td>A type of box that appears on a display screen to present information or request input. A dialog box requires that you to respond to it to continue.</td>
</tr>
<tr>
<td>Down</td>
<td>A key used to move the cursor to the first enterable field in the next record. “Down” moves you lower in a pull-down list and on a List of Values.</td>
</tr>
<tr>
<td>Drop-down List</td>
<td>Displays three or more values for a field. A field with a down arrow icon contains a drop-down list.</td>
</tr>
<tr>
<td>Edit</td>
<td>Displays a window that allows you to add, change, or delete text. “Edit” is especially useful in entering and updating Dynamic Help.</td>
</tr>
<tr>
<td>Enter Query</td>
<td>Allows you, in a form, to query search criteria to see what information is already in the database. When used, “ENTER QUERY” is displayed in the Status Line.</td>
</tr>
<tr>
<td>Execute Query</td>
<td>Allows you to execute a query to search the database. After a query is executed, data that matches the search criteria is displayed.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Allows you to exit from a specific form or window by closing the form or window. From query mode, Exit allows you to cancel a query and takes the form out of query mode. From the menu, Exit allows you to close the Banner system program.</td>
</tr>
<tr>
<td><strong>Exit with Value</strong></td>
<td>Allows you to exit from a specific calling form to a called form with highlighted values, values which are then entered into the called form’s field.</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td>An area in a form where existing information is displayed, or where you can enter a query or change information. Banner describes fields as: enabled, disabled, enterable, or display only.</td>
</tr>
<tr>
<td><strong>Form</strong></td>
<td>An online document that allows you to enter and/or display the information stored in the database.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>A function that allows you to display the Oracle help window for a current field.</td>
</tr>
<tr>
<td><strong>Inquiry Form</strong></td>
<td>A form that allows you to look up existing information in the database. (An inquiry form will have the letter “I” in the third position of the form name.)</td>
</tr>
<tr>
<td><strong>List of Values (LOV)</strong></td>
<td>A window that lists the values you can select for a field on a form. These are values that have been defined as acceptable and valid for the field.</td>
</tr>
<tr>
<td><strong>Menu Bar</strong></td>
<td>A menu, located at the top of every Banner form, allows you to access pull-down menus, including File, Edit, Options, Block, Field, Record, and Query.</td>
</tr>
<tr>
<td><strong>More...</strong></td>
<td>An indicator that appears in the lower right corner of each window of a series of related forms (including the last form). “More…” informs you that there are additional forms that can be accessed to complete a process.</td>
</tr>
<tr>
<td><strong>Next Block</strong></td>
<td>Allows you to move the cursor to the next information area (block), with at least one enterable field.</td>
</tr>
<tr>
<td><strong>Next Field</strong></td>
<td>Allows you to move to the next enterable field in the current information area.</td>
</tr>
<tr>
<td><strong>Next Item</strong></td>
<td>Allows you to move to the next enterable field in the current information area.</td>
</tr>
<tr>
<td><strong>Next Record</strong></td>
<td>Allows you to move the cursor to the first enterable field in the next record. If the cursor is moved to the last record, a new record is created.</td>
</tr>
<tr>
<td><strong>Object</strong></td>
<td>An object is a form, a job, a menu or a QuickFlow used in Banner.</td>
</tr>
<tr>
<td><strong>Option List</strong></td>
<td>A dialog box that displays two or more items to choose.</td>
</tr>
<tr>
<td><strong>Pop-Up Window</strong></td>
<td>A dialog box, alert box, or list of values that appears in a separate window.</td>
</tr>
<tr>
<td><strong>Previous Block</strong></td>
<td>A previous area of information with at least one enterable field. If the previous area is another window, that window is opened.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Previous Field</td>
<td>Allows you to move the cursor to the previous enterable field.</td>
</tr>
<tr>
<td>Previous Item</td>
<td>Allows you to move the cursor to the previous enterable field.</td>
</tr>
<tr>
<td>Previous Record</td>
<td>Allows you to move the cursor to the first enterable field of the previous record.</td>
</tr>
<tr>
<td>Query Form</td>
<td>A form used to look up existing information in the database. (A query form has the letter “Q” in the third position of the form name).</td>
</tr>
<tr>
<td>Quick Flow</td>
<td>A set of forms that are linked together in order to help you complete a process within Banner. When you use Quick Flow, it opens the first form in the set and the next form is automatically opened until the process is complete.</td>
</tr>
<tr>
<td>Record</td>
<td>A set of related information that is linked to one person in Banner.</td>
</tr>
<tr>
<td>Rollback</td>
<td>A function, from an application or inquiry form, that clears all information and returns you to the key block area. <strong>Rollback</strong> is a standard button and appears on all forms. In validation forms, rollback returns you to the first enterable field on the calling form.</td>
</tr>
<tr>
<td>Save</td>
<td>A command that allows you to take entered data on a form and store it in the database.</td>
</tr>
<tr>
<td>Scroll Down</td>
<td>A process that allows you to move down repeating records or lists of information that cannot be displayed in one window.</td>
</tr>
<tr>
<td>Select</td>
<td>Allows you to choose an item by highlighting it or clicking it with the mouse.</td>
</tr>
<tr>
<td>Show Keys</td>
<td>Allows you to display the list of keyboard options.</td>
</tr>
<tr>
<td>Up</td>
<td>A key used to move the cursor to the first enterable field in the previous record. “Up” moves you toward the top of a pull-down list and on a List of Values.</td>
</tr>
<tr>
<td>Validation Form</td>
<td>A form used to define the values that can be entered in specific fields on application forms. (A validation form will have the letter “V” in the third position of the form name).</td>
</tr>
<tr>
<td>Window</td>
<td>An area where information is displayed.</td>
</tr>
</tbody>
</table>
### Appendix B: Compatible Browsers

The following lists the Web browsers supported by Banner7.x:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Banner INB</th>
<th>Banner INB via Luminis Portal</th>
<th>Banner Self-Service</th>
<th>Banner Self-Service via Luminis Portal</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windows</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>XP (SP 1 &amp; 2)</td>
<td>IE 6.x *</td>
<td>IE 6.0; Netscape 7.2^</td>
<td>IE 6.x; Netscape 7.01, 7.2; Mozilla 1.7x; Firefox 1.0</td>
<td>IE 6.0; Netscape 7.2</td>
</tr>
<tr>
<td></td>
<td>Netscape 7.0x *^</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2000</td>
<td>IE 6.x*</td>
<td>IE 6.0; Netscape 7.2^</td>
<td>IE 6.x</td>
<td>IE 6.0; Netscape 7.2</td>
</tr>
<tr>
<td></td>
<td>Netscape 7.0x *^</td>
<td></td>
<td>Netscape 7.01, 7.2; Mozilla 1.7x</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OS9</td>
<td>N/A</td>
<td>N/A</td>
<td>IE 5.1.7</td>
<td>IE 5.1.7</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Netscape 6.2.x</td>
<td>Netscape 7.0.2</td>
</tr>
<tr>
<td>OSX (minimum of 10.3)</td>
<td>Safari 1.2 ^</td>
<td>Safari 1.2^</td>
<td>IE 5.2.3</td>
<td>Netscape 7.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Netscape 7.1</td>
<td>Safari 1.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*requires Oracle JInitiator 1.3.1.18

^requires Sun plug-in 1.4.2